FingerPrint® GSi
Screen Dump Graphic Utility Card for the Apple IIGS.

Owners Manual

THIRDWARE COMPUTER PRODUCTS
A Division of Precision Software, Incorporated
THIRDWARE COMPUTER PRODUCTS (TCP) warrants this product free from defects for a period of FIVE years from the date of purchase. During this period, TCP will, at its own option, repair or replace at NO CHARGE any defective components provided that the defective product is returned with a valid Return Merchandise Authorization, prepaid to TCP. If warranty card has not been registered with TCP, dated proof of purchase must be included with the defective product. This warranty does not cover damage caused by accident, misuse, misapplication, unauthorized service or modification. In no event will TCP be held liable for incidental or consequential damages of any kind in connection with use or misuse of TCP’s products.

To obtain a valid Return Merchandise Authorization number, please call TCP’s technical support department between 2:00-5:00 PM EST.

Any items returned without a valid Return Merchandise Authorization number will be returned to sender unopened.

Fingerprint® is a registered trademark of Precision Software. Incorporated.
Apple and IIGS® are registered trademarks of Apple Computer. Inc.

This product contains material from the ORCA/M Floating Point Libraries, copyright 1987 by Byte Works. Inc. Used with permission.
# Table of Contents

1. **About This Manual** ................................................................. 1
2. **The FingerPrint GSi** ............................................................... 3
3. **Set Up and Installation** ......................................................... 5
   - What you should have .......................................................... 5
   - Setting DIP switches ............................................................. 7
   - Changing the Printer DIP switch Settings ............................. 11
   - Changing the Printer Port DIP Switch Settings .................... 11
   - Installing the FingerPrint GSi ............................................... 12
   - Opening your Apple IIGS ..................................................... 13
   - Plugging in the Fingerprint® GSi ......................................... 13
   - Attaching the activator button ......................................... 14
   - Closing your Apple IIGS ..................................................... 16
   - Quick Installation summary ............................................. 16
   - Testing the installation ...................................................... 16
4. **Getting To Know The FingerPrint GSi** .............................. 19
   - Your first screen dump ....................................................... 20
   - Exploring the FingerPrint GSi menus ................................. 22
     - Accessories menu ....................................................... 23
     - File menu ................................................................... 23
     - Options menu ............................................................. 25
     - Printers menu ............................................................. 28
     - Special menu ............................................................. 28
     - Saving your first screen ............................................... 29
5. **Printing Screen Images** ....................................................... 31
   - Graphic Printing Tools ....................................................... 32
     - Inverse ...................................................................... 32
     - Color ....................................................................... 32
     - Zoom ....................................................................... 33
     - Rotate 90 degrees ....................................................... 34
     - Horizontal Flip .......................................................... 34
     - Vertical Flip ............................................................... 35
     - Billboard ................................................................. 35
     - Fast Billboard ............................................................ 37
   - Cropping Images ............................................................... 38
     - Graphic cropping ....................................................... 38
     - Coordinate cropping ................................................... 41
   - Page formatting ............................................................... 42
     - Left margin ............................................................... 43
     - Copies ................................................................. 43
     - Top of form ............................................................. 43
     - Line feed ............................................................... 43
6. Dump To Super Hires ............................................. 46
7. System Selection and Disk Functions ......................... 47
   System selection ..................................................... 47
   Disk Functions ....................................................... 48
   Save screen ............................................................. 48
   Load screen ............................................................. 49
   Catalog ................................................................. 50
   Rename ................................................................. 50
   Delete ................................................................. 50
   Lock/Unlock ......................................................... 51
   Disk Space ............................................................. 51
8. Set/View/Scan Screens .............................................. 52
   Set screen .............................................................. 52
   view screen ............................................................ 52
   Scan screen ........................................................... 53
9. Using The Desktop Accessories .................................... 54
   Calculator ................................................................. 54
   Calendar ................................................................. 55
   Typewriter ............................................................... 55
10. The FingerPrint Slide-Show Program .............................. 57
    Create ................................................................. 58
    Run ................................................................. 61
    Modify .............................................................. 62
    Erase ............................................................... 62
    Display .............................................................. 63
    Startup .............................................................. 63
11. Using Other Printer Interfaces ...................................... 65
12. Troubleshooting ....................................................... 66
    FingerPrint® GSi does not print correctly ..................... 66
    FingerPrint® GSi gets stuck .................................... 66
    FingerPrint® GSi does not Interrupt correctly ............... 67
    How to get help .................................................... 67
13. Reference Section ...................................................... 69
    DIP Switches ......................................................... 69
    Changing ROMS .................................................... 72
    Dumping the FingerPrint® Menus ............................... 75
    Ideas for Applications ............................................. 76
1. About This Manual

This manual is for FingerPrint® GSI owners. New owners should read chapters 2-4. after which you will be able to capture and dump screens save images to disk and navigate through the different menus. A more In depth tour of the different options and uses of the Fingerprint® GSi are covered by topic in chapters 5-11 Chapter 12 shows you how to identify and resolve problems. The last chapter is designed to serve as a reference section where you can find DIP switch settings, suggestions for applications and other useful technical information.

> Chapter 2. "The FingerPrint® GSi". gives a short description of the FingerPrint® GSI and some of Its uses and applications.

> Chapter 3. “Set up and Installation”, takes you through the steps of setting up your FingerPrint® GSI card, setting DIP switches, installing the card In your Apple IIGS and testing the installation to make sure that everything is working correctly.

> Chapter 4. “Getting to Know the FingerPrint® GSI”. gets you started by showing you how easy It is to make your first screen dump, then takes you on a guided tour of the menus describing the different options, and ends by showing you how easy It is to save an image to disk.

> Chapter 5. "Printing Screen images", shows you how to use the graphic printing and page formatting tools to enhance your screen dumps and print billboards.

> Chapter 6. “Dump to Super Hires”, shows you how to convert Low and Hires graphic images to Super Hires.

> Chapter 7. “System Selection and Disk Functions”, shows you how to change operating systems and how to use the powerful disk functions to copy, rename, delete and catalog files.
Chapter 8. ‘Set/View/Scan Screens’, shows you to select different video memory pages. scan the video memory pages and view their contents.

Chapter 9. ‘Using The Desktop Accessories’, shows you how to use the FingerPrint® GSi’s calendar, calculator, and typewriter desktop accessories.

Chapter 10, ‘The FingerPrint® Slide-Show’, shows you how create, modify run and display slide-show presentations using the FingerPrint® Slide-Show program and images saved to disk with the FingerPrint® GSi card.

Chapter 11. “Using Other Printer Interfaces”, shows you how to print screen dumps using a FingerPrint® G+ or FingerPrint® SuperSerial card Instead of the IIGS internal printer port.

Chapter 12. ‘Troubleshooting”, shows you how to resolve unplanned problems as well as how to contact Thirdware Computer Products for technical support.

Chapter 13. “Reference Section”. contains technical information and suggestions for possible applications of the FingerPrint® GSi,

More detailed information regarding specific applications of the FingerPrint® GSi in education and at home can be found. in Thirdware Computer Products “FingerPrint® User’s News Letter, published six times annually, One years subscription costs $3.00. To subscribe, send us the subscription application you received In the box, or send us a note requesting a subscription, Make sure to include a check for $3.00 or your subscription will not be processed.

If you have a specific application of the FingerPrint® GSi card that you would like to share with other FingerPrint® users, we would be glad to include it in the ‘Fingerprint® User’s News Letter. Just send us a note with your application and we will publish it on a first come first serve basis

2. The FingerPrint GSi

The FingerPrint® GSi is a screen dump graphic utility card for the Apple IIGS which provides you with the ability to capture any image from the screen of your computer and print it out on your printer at the touch of a button. This is called screen dumping. It's like having your computer connected to a photocopier, when ever there is something on the screen that you want to print. Just press the FingerPrint® activator button followed by the return key, and the image will be printed by your printer.

The FingerPrint® GSi also provides you with the ability to enhance images before screen dumping them. You can rotate, enlarge, crop or use any of the many other options to enhance your images and position them on the page.

The FingerPrint® GSi has a special function that allows you to print images enlarged up to 130’ x 100’ call “Billboard”. With this function, you can print any image as large as you want it. The image as printed out in rolls of paper similar to wallpaper which you simply paste together like vertical panels. This function is great for making posters or even scenery for a school play.

Any image that you want to use in paint, graphic or desktop publishing programs can be captured by pressing the FingerPrint® button and saved to disk. In this way, you can create libraries of images to use in newsletters, diagrams, pictures and much more. You can also use the included FingerPrint® Slide-Show program to create computerized presentations of your captured images. This is a great way to create presentations for your class, home or once.

The FingerPrint® GSi is a fantastic tool to create and deliver customized instructional materials, images generated by educational software can be captured and printed to create work sheets, tests or homework assignments. Images can be saved to disk and, using the FingerPrint® Slide-Show program, teachers can create presentations which can be displayed to a class by connecting a TV or video monitor to the computer.

The FingerPrint® GSi allows you to print results screens from arcade, adventure and drill and practice software which can be
used to remember highest scores, motivate students, shown to parents, or displayed on the class bulletin board.

The FingerPrint® GSi provides an added bonus of three desktop accessories which can be accessed at a touch of the FingerPrint® button. In the middle of any program, at any moment. You can check present, past and future dates on the calendar accessory. make quick calculations on the calculator accessory, or type quick notes and send special printer control commands to your printer by using the typewriter accessory.

The FingerPrint® GSi can be installed in any slot, even reserved slots like slot 3. and does not have to be declared in the IIGS control panel.

You can connect your printer to any of the IIGS Internal serial ports or use an additional printer interface card such as the FingerPrint® G+ parallel Interface card or the Fingerprint® SuperSerial serial Interface card.

The FingerPrint® GSi Is covered by a FIVE YEAR NO HASSLE warranty which covers your card against faults and errors arising from faulty parts or manufacturing and also entitles you to free technical support from 2:00PM-5:00PM EST. Make sure to save your sales receipt to prove your purchase date!

Now it’s time to show you how to set up and Install your FingerPrint® GSi In your Apple IIGS computer.
3. Set Up and Installation

This chapter will show you how to set up, install and test your FingerPrint® GSi card. If you have previous experience with the FingerPrint® GSi installation procedure and feel confident, skip to the ‘Quick installation summary’ section of this chapter if this is the first time you install your FingerPrint® GSi card. Read through the whole chapter carefully.

There isn’t any trick to setting up your FingerPrint® GSi, just follow these instructions and you’ll be printing screen dumps before you know it.

The first thing you should do is check that you have everything that should have come in the box with your FingerPrint® GSi.

What you should have

The box that your FingerPrint® GSi came in should contain the following items:

- 1 FingerPrint® GSi card.
- 1 FingerPrint® activator button w. blue ribbon cable.
- 1 FingerPrint® GSi owners manual.
- 1 FingerPrint® Slide-Show program diskette.

Make sure that you have everything listed above. If you’re missing anything, contact the dealer where you purchased your FingerPrint® GSi.

If you would like the Slide-Show program on a 3 1/2’ diskette, you can order one directly from Thirdware Computer Products.

As soon as you have made sure that you have everything, please take a moment to fill out the warranty registration card found in the middle of this manual and put it in the mail.
If for some reason you need to return your Fingerprint® card to Thirdware Computer Products, DO NOT RETURN ANY PRODUCT OR PART OF A PRODUCT WITHOUT FIRST HAVING BEEN ISSUED A RETURN MERCHANDISE AUTHORIZATION BY THIRDWARE’S TECHNICAL SUPPORT DEPARTMENT OR THE PACKAGE WILL BE RETURNED UNOPENED.

Setting DIP switches

Once you've inventoried what came with your FingerPrint® GSi. The next step is to set the DIP switches. The DIP switches tell the FingerPrint® GSi what printer you normally will be using, and which port it will be connected to. By setting the switches, you avoid having to select a printer and a printer port from the menu every timer you want to print using the FingerPrint® GSi.

Look at Figure 1 above. As you can see the DIP switches are located on the upper right hand part of the FingerPrint® GSi card. You can also see the button cable socket where the FingerPrint® activator button is connected, and the ROM chip that contains the “firmware” or program that controls the card.

Later on. In the section entitled 'Installing the FingerPrint®
GSi". we will tell you how to connect the FIngerPrint® activator but ion Information regarding installation of new ROM chips or special program ROM chips can be found in the Reference Section at the end of this manual.

Now lets get back to setting the DIP switches. The DIP switch consists of eight small switches which can either be In the “ON” (up position), or In the "OFF" (down position). Look at the diagram In Figure 2.

![Dip switches diagram](image)

Figure 2.

Let’s first see how to set the DIP switches for the printer you will be using. The DIP switches that determine what printer you are using are switches 1 - 5.

The FingerPrint® GSi comes from the factory with switches 1-5 set for the Apple ImageWriter II printer. As you can see, the switch settings for the Apple ImageWriter II are:

<table>
<thead>
<tr>
<th>SW1</th>
<th>SW2</th>
<th>SW3</th>
<th>SW4</th>
<th>SW5</th>
</tr>
</thead>
<tbody>
<tr>
<td>on</td>
<td>on</td>
<td>on</td>
<td>on</td>
<td>on</td>
</tr>
</tbody>
</table>

If you are using an Apple ImageWriter II printer as your default printer, check to make sure that the switches are set as described above. If for some reason the card came with the switches set differently, set them as they appear in Figure 2. using your finger or a pen to move the switch then go on to the section entitled “Changing the Printer Port DIP Switch Settings”.

If you are using a printer other than the Apple ImageWriter II, you will have to change DIP switches 1-5. See the section entitled “Setting Printer DIP Switches on the following page."
Changing the Printer DIP switch Settings

You only have to read this section if you are using a printer other than the Apple ImageWriter II.

Take a look at the table on the following page. There you will find all of the settings necessary to use most printers. If your printer is not listed, try the Epson Generic settings. If these do not work properly, contact Thirdware Computer Products customer service department and they will tell you how set the switches for your printer. Be sure to write down the setting they give you and fill in one of the blank switch diagrams listed in the "Reference Section" at the end of the list of printer switch settings. In that way you will know where to find the setting should the need arise in the future.

When you know the DIP switch settings for the printer you are using, change the switch settings, using your finger or a pen to move the switch, so that switches 1-5 are correctly positioned.

Check the DIP switch setting with the setting in the table on the following page or the setting you received from Thirdware Computer Products customer service department. Are they set correctly?
**Printer Dip Switch Settings**

Note: Switches 6 - 7 set the default port. Switch 8 has no function and can be ignored.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Apple ImageWriter II</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Apple ImageWriter I</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Apple ImageWriter LQ</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Apple Scribe</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cannon</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Citoh</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Citoh 8510</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Epson (newer models)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Epson (generic)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Epson JX</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>IDS Prisma</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>IDS Color</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Old 82, 83, 92, 94</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Old 100 &amp; 200 series</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Quadjet</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Fastext</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Panasonic</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Gemini</td>
</tr>
</tbody>
</table>
Changing the Printer Port DIP Switch Settings

Now, let’s see how to set switches 6-7 for the printer port or auxiliary interface card to which your printer is connected. Your printer can be connected to four possible printer ports. The first two, Port I and Port 2, are the two serial ports at the back of your IIGS computer. Your printer should be connected to one of these two. The second two ports, FingerPrint® G+ and FingerPrint® SuperSerial, are additional interface cards that you can Install to connect a parallel or serial printer to your IIGS. The FingerPrint® G+ is a parallel interface, and the FingerPrint® SuperSerial is a serial Interface. Either one can be used for connecting a printer to your IIGS.

Look at the chart below to see how the switches 6-7 should be set for the port you will be using.

<table>
<thead>
<tr>
<th>Port 1</th>
<th>Port 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>FingerPrint® Parallel</td>
<td>FingerPrint® Serial</td>
</tr>
</tbody>
</table>

Use your finger or a pen to move switches 6-7 so that they are correctly positioned for the port you will be using.

Now you’re all set to Install your FingerPrint® GSi in your IIGS.
Installing the FingerPrint GSi

Now you’re ready for the next step. Installing the FingerPrint® GSi. This procedure is divided into four easy steps—opening your Apple II GS, plugging in the FingerPrint® GSi, attaching the activator button and finally closing your Apple II GS.

Opening your Apple II GS

Before you can get at the slots to plug in the FingerPrint® GSi, you need to remove the lid of your Apple II GS. If you feel unsure about opening your Apple II GS, go to the ‘Setting Up Your Apple II GS manual that came with your computer and see pages 18-19.

IMPORTANT!

Make sure the Apple II GS power switch is off, but leave the power cord plugged into a grounded outlet. This keeps your computer system grounded. If the power has been on, wait at least 30 seconds after turning off the power before connecting anything to or disconnecting anything from the Apple II GS.

To remove the Apple II GS lid, wrap your hands around the rear corners of the Apple II GS case, and hold the lid latches in with your index fingers while you push up on the lid with your thumbs. When you feel the lid release, lift it all the way off the case and put it to one side.

Plugging In the FingerPrint® GSi

Before plugging in the FingerPrint® GSi make sure to touch the power supply case (see Figure 4 below) to discharge any static electricity that may be on your clothes or body.
Now that the computer is open and you have discharged any static electricity that may have been on your clothes or body, you can go ahead and plug the FingerPrint® GSi into any free slot (we recommend slot 3, see below for details). **The FingerPrint® GSi does not have to be declared to the control panel** and is fully transparent to the computer. That is to say that the Apple IIGS does not have to know that the FingerPrint® GSi is installed, or where it is installed.

If you're unsure about plugging in the card, read the instructions on page 20 of the “Setting Up Your Apple IIGS manual that came with your computer.

We recommend that you use slot 3 (See Figure 3 above) because it can not be used by other cards as it is reserved for software compatibility as the slot where the 80-column adapter was normally installed in the old Apple//e. Because the FingerPrint® GSi is transparent to the computer. It will in no way affect your software and by residing in slot 3 it will not occupy a slot that other cards could otherwise use.

When you handle the card, avoid touching the gold fingers along the bottom edge of the card. The moisture from your fingers could attract dust, which would weaken the card's connection to the computer. You'll have to exert some pressure to get the card into the slot. (If it were a loose fit, it would be a loose connection.) But don't wiggle the card from side to side in your efforts to insert it. Rock it back and forth until it's firmly seated in the slot.
Once the card is firmly in place we can go on to attaching the FingerPrint® GSi activator button.

**Attaching the activator button**

the FingerPrint® GSi normally comes from the factory with the activator button and its blue ribbon cable already attached to the card. If the cable has become disconnected, just plug the cable back into the cable socket in the upper left hand corner of the card. (See Figure 5 below).

![Figure 5](image)

With the blue ribbon cable firmly connected to the card, look at the front of your computer for a place to attach the self-adhesive button end. We recommend that you attach the button on the flat surface at the front of the computer. (See Figure 6 below)

![Figure 6](image)
If you don’t want to use the self adhesive to attach the button use double sided tape. To protect the button from being removed by small children with Inquisitive fingers, cut a 1 1/2” square piece of clear self adhesive contact paper, normally used to cover books. and place it over the button.

Before going on to the next step, make sure that the card is firmly in place and that the button is connected to the card. Don’t worry about the button coming loose, it’s made that way so that the card will not be damage if someone pulls on the button. Just plug it back into its socket.

**Closing your Apple IIIGS**

Replace the lid of your Apple IIIGS by laying the front edge of the lid in the groove in the front of the Apple IIIGS case and lowering the backedge of the lid into place. Press down on the back corners of the lid until you hear the latches click shut.

If you have any doubts about closing the lid, see page 21 In the "Setting Up Your Apple IIIGS" manual that came with your computer.

Congratulations! You’ve Just installed your FingerPrint® GSi. Now lets quickly summarize the installation and then go ahead and test the FingerPrint® GSi card on your printer.

**Quick installation summary**

This is a summary of the steps you should follow when installing the FingerPrint® GSi in your Apple IIIGS.

1. Check that you have received everything.  
2. Set DIP switches.  
3. Open Apple IIIGS.  
4. Plug FingerPrint® GSi into a free slot.  
5. Attach activator button and blue ribbon cable.  
6. Close Apple IIIGS  
7. Test installation.
If you feel unsure about any of these steps, please refer to the appropriate sections in this chapter.

Testing the installation
Now you’re ready to test your FingerPrint® GSi and see if everything is properly connected and functioning correctly.

First, let’s see if the Fingerprint® GSi is functioning properly. Power on your IIGS. For testing purposes, it doesn’t matter if these is a diskette in the disk drive or not but it is always better to wait until the disk drive stops. Press the red Fingerprint® GSi activator button and release it. As soon as you release the button your screen should clear and a menu similar to the one below should appear. This is the FingerPrint® GSi main menu.

![Menu Image]

If the FingerPrint® GSi menu did not appear on your screen, power off your IIGS and repeat the procedure. If the menu does not appear the second time, repeat the installation procedure to make sure that the card is firmly seated in the slot, and check to see if the blue ribbon cable of the activator button is correctly plugged into the socket on the FingerPrint® GSi board. Repeat the test procedure. If the FingerPrint® GSi menu does not appear, try some of the other suggestions in chapter 12, “Troubleshooting” and as a last resort contact your dealer or Thirdware Computer Products customer service department.

As soon as the menu appears as shown above, you know that the card is functioning properly. The next step is to test the printer to make sure that the DIP switches are set correctly for your printer and also to make sure that your printer is connected to the port selected with DIP switches 6-7.
Look at the menu on your screen, you can see that the cursor is positioned on the Print Screen option. Move the mouse, or use the arrow keys, so that the cursor moves leftwards until it is on top of the “Special” option. Press the button on your mouse, or press the “return” key. The "Special" option sub menu, similar to the one in figure 7, should now appear on your screen.

![Menu with Print Screen and Special options]

Figure 8.

Make sure that your printer is connected to the port which you selected by setting DIP switches 6-7. Turn your printer on, and make sure that it has paper and is ‘on-line.

Using the mouse, or arrow keys, move the cursor down the menu until it is in position over the “Printer test” option. Click the mouse button, or press the "return" key. Your printer should now print ‘THIS IS THE FINGERPRINT GSi TEST’.

If your printer did not print the message, turn your printer off and turn it back on again. Repeat the test, if it still does not work check DIP switches 1-5 to make sure that they are correctly set for the printer you are using, and make sure that you are using the port you specified with switches 6-7. If it still does not print the message, check to make sure that the printer cable is properly connected, that the printer is turned on, that the printer is on-line and that there is paper in the printer. If it still does not work, contact your dealer or Thirdware Computer Products customer service department.

To get back to the main menu, move the mouse down to the last option (represented by a "<-I" symbol) and click the button, or just press the “esc” key. To leave the FingerPrint® GSi main menu just repeat the last step, i.e. move the cursor to the "<-I” symbol and click with the mouse, or just press the “esc” key. This is how to back-up in any part of the FingerPrint® GSi menus.
Now you're all set to learn how to use your Fingerprint® GSi.
4. Getting To Know The FingerPrint GSi

Now that you’ve installed your FingerPrint® GSi and tested to make sure that its working correctly, let us Introduce you to some of the wonderful things that you can do with your FingerPrint® GSi.

The first thing you need to know, is how to activate your FingerPrint® GSi. You already know that because otherwise you would not have past the last chapter on testing the installation.

All that you have to do, is lightly press and release the FingerPrint® GSi activator button at any moment, from inside of any application or program. Once the button has been released, the FingerPrint® GSi main menu will appear on the screen.

![File Options Printers Special Print Screen](image)

Figure 9.

The second thing you need to know, is how to navigate, or move around, the various menus. The FingerPrint® GSi menus accept input from the mouse and/or keyboard. That means that you don't have to stop using the mouse when you're using FingerPrint® GSi. Move the mouse around, or use the right/left arrow keys, until you get the feel of how easy it is to move around the main menu.

To select a menu option, position the cursor on top of the desired action by moving the mouse or using the arrow keys, then click the mouse button, or press the return key. A sub-menu, or dialog box will open, or In the case of a command option, the command will be executed.
To exit from an option, press the “esc key or Just position the mouse on the “<- |” symbol and click the mouse button. If you do this from the main menu, you will find yourself right back where you were when you pressed the Fingerprint® GSi activator button.

See how easy it is to enter/exit the menus!

Now practice entering/exiting your FingerPrint® GSi card and moving around the menus until you feel comfortable.

Your first screen dump

Load any program and when you see a screen that you wish to print, press and release the activator button. The FingerPrint® GSi main menu will appear and the cursor will automatically position itself on the ‘Print Screen” option. Make sure that your printer is on. and set “on-line”. Now, click the mouse button, or press the “return” key. The screen will appear on the monitor and your printer should now start printing.

That was easy!

When the FingerPrint® menu returns you can return to your program or use other options to manipulate or enhance the image.

You will notice that the image was printed in B/W. If the Image appears in color on your screen and your printer has a color ribbon you can print the screen in color by selecting the “Color” option in the “Graphic Printing Tools” sub menu of the “Options” menu. To do this. Just move the cursor on to the “Options” menu, click with the mouse or press the “return” key. A new sub menu will appear. Then move the cursor on to the “Graphic Printing Tools” menu, click with the mouse or press the “return” key. A new sub menu will appear.
Move the cursor until the “Color” option is highlighted, and click once with the mouse or press the “return” key. A check mark will appear to the right of the “Color” option. This means that the option has been activated. To deactivate this option, simply highlight it and click the mouse button or press the “return” key and the check mark will disappear.

Now leave the “Graphic Printing Tools” menu by positioning the cursor on the “<-1” symbol and clicking the mouse, or just press the ‘esc” key. Position the cursor on the ‘Print Screen’ function at the bottom of the “Options” menu and click once with the mouse or press the “return key. Your image will now be printed in color. You will notice that the printer prints slower when printing in color. This is because the print head must pass over the same line many times, once for every color.

The “Print screen” function can be found in the main menu, the “Options” menu and the “File” menu so that you don’t have to return to the main menu every time you wish to print.

To stop the printer while an image is being printed just press the space bar and the FingerPrInt® menu will reappear.

To go back to your program just position the mouse on the "<-I" symbol and click the button, or press the “esc” key.

**Making screen dumps is as easy as 1-2-3!**

1. **Press the FingerPrint® GSi activator button,**

2. **Click the mouse button, or press the “return” key.**

3. **Position the mouse on the “<-| symbol and click the button, or press the “esc” key.**
Exploring the FingerPrint GSi menus

Now that you know how to make simple screen dumps, let us tell you what can be found in each of the different menus. We will quickly describe each menu and what can be found there. Operating and user instructions for the different functions can be found in chapters 5-11 of this manual.

It would be a good idea to move around each particular menu as you read about its options and in that way get a feel for each menu.

<table>
<thead>
<tr>
<th>File</th>
<th>Options</th>
<th>Printers</th>
<th>Special</th>
<th>Print Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌡️</td>
<td>Represents the Accessories sub menu.</td>
<td>←I Represents the “exit” option when using the mouse.</td>
<td>File Represents the File Options sub menu.</td>
<td>Options Represents the Options sub menu.</td>
</tr>
<tr>
<td>File</td>
<td>Represents the File Options sub menu.</td>
<td>Printer Represents the Printers sub menu.</td>
<td>Special Represents the Special Options sub menu.</td>
<td></td>
</tr>
</tbody>
</table>

Options contained in sub menus are turned on or off by clicking once with the mouse or pressing the return” key. A check mark will appear to the right of the option to indicate that the option has been activated. To deactivate an option, simply click again with the mouse or press the ‘return” key and the check mark will disappear.

Some options contain sub menus or windows where you can select options or enter variables. To leave a sub menu or window, position the mouse on the ‘←I” symbol and click the button, or press the “esc” key. Some sub menus and windows will automatically return you to the previous menu when you select an option or finish entering variables. Exceptions to this rule are the Typewriter accessory and ‘Headings options which require that you press the 🍊 (open apple) and the “escape” key simultaneously to exit.
Accessories menu

The accessories menu contains an information screen and the FingerPrint® GSi desktop accessories.

"About FingerPrint® GSi" contains information regarding what version of the firmware or ROM chips are installed on your card as well as the names of the designers and the telephone number and address to Thlrdware Computer Products.

The Flngerprlnt® GSi desktop accessories consist of a calender, calculator and a typewriter. These accessories can be accessed at any moment, from inside of any program to make quick calculations, type diskette labels, add explanatory text to screen dumps, check future and past dates and lots more. A detailed description of their use can be found in chapter 9.

File menu

The file menu contains six options which allow you to save/ load screen images to/from disk, as well as options to set screens for printing, view the screen that was on the monitor when you pressed the activator button, and scan the different screens present in memory.
The first option, “Print Screen” will print the screen currently selected and works just like the Print Screen” found in the main menu.

The second option, “Dump to Super Hires”, allows you to convert any Hires or Lowres screen to Super Hires. This is great if you want to import graphic images captured from one program and use them in paint or drawing programs that work in Super Hires. An interesting feature of this option is that you can use all of the cropping, color, and zooming features when you convert screens just as if you were printing the image to a printer.

The third option, “Disk functions”, allows you to perform a number of very powerful disk-oriented functions such as: save or load any screen image to or from disk, catalog a disk or volume, rename, delete, lock and unlock files as well as check the amount of free space available on any disk. These options are a great way to avoid having to use special utility programs or leave a program to go to ProDOS to check catalogs or change file names. Read more about these very powerful features in chapter 7.

The fourth option, “System selection”, is used to tell the Fingerprint® GSi which operating system you wish the card to work in, either DOS 3.3 or ProDOS. The advantage with this is that you can run a ProDOS program and save a screen from that program to a DOS 3.3 diskette or visa versa.
The fifth option. “Set Screen”, allows you to select any of the available video memory pages for printing or saving to disk. See chapter 8 for a more detailed description of this and the following two options.

The sixth option. ‘View screen”, allows you to view what was on the screen of your computer when you pressed the FingerPrint® activator button or the screen you selected with the “Set screen” option.

The seventh and last option, “Scan Screens”, allows you to scan the contents of the different video memory pages by moving the mouse left or right, pressing the space bar or using the left and right arrow keys. When you have found the screen you wish to select, press the “return” key or click the mouse button, the menu will reappear and that screen set as the screen for printing, saving or loading to or from disk.

Options menu

The options menu contains six options which allow you to manipulate and crop screen images, enter page headings, set page formats and set printer fonts and type sizes. A detailed description of each option can be found in chapter five.

The first option, “Graphic Printing Tools”, opens a sub menu which contains eight options to manipulate the printing of screen images.
The “Inverse” option will reverse the foreground and background colors so that an image with black text and a white background will be printed with white text on a black background.

The “Color” option turns the color printing capability on or off. The default setting is off.

The “Zoom” option allows you to enlarge the width and height of an image by a variable factor of one to ninety-nine times its original size. Different values can be entered for height and width in order to change the aspect ratio of the printed image.

The “Rotate 90” option allows you to print any image sideways. This is very useful when making banners, or when printing images which have been enlarged and would not fit on the page if printed normally.

The “Vertical Flip” option will print an upside down image of the screen image.

The “Horizontal Flip” option will print a mirror image of the screen image.

The “Billboard” option allows you to print an image up to 130 feet wide by 100 feet high. The images is printed on a series of paper strips just like rolls of wallpaper. Just paste the strips side-by-side and you can cover your walls with your favorite adventure characters or create scenery for school plays.

The “Fast Billboard” option is just like the “Billboard” option except that the image is printed as a series of asterisks. This is much faster and saves color ribbons if you intend to color in the image.

The second option of the “Graphic printing tools” menu “Graphic cropping”, allows you to print just a portion of the screen image by moving a flexible box which is superimposed on the screen image so that it covers the portion of the screen you wish to print.
The third option, ‘Coordinate Cropping’, has the same affect as the previous option but instead of displaying the image a window will appear where the screen coordinates for the upper left-hand and lower right-hand corners of the box can be changed by using the mouse or arrow keys.

The fourth option, ‘Headings’, opens a window where you can enter a text string which will be printed as a heading at the top of the page before every screen dump.

The fifth option, ‘Page Format’, opens a sub menu with four options.

- The “line Feed” option makes your printer feed a line at the end of every line of print. The default setting is on.

- The “Top of Form” option makes your printer feed the paper to the top of the next page after every screen dump.

- The “Left Margin” option opens a window where you can set the position of the left margin. This is useful when you want to print images in two or more columns across the page.

- The “Copies” option opens a window where you can specify the number of copies the printer will print of the screen image.

“The sixth option in the “Options” menu, ‘Printer text commands’, opens a sub menu which allows you to select from five fonts and type sizes combinations. Selecting any of these options will configure your printer accordingly.

The last option is a conveniently placed “Print screen” to save you the trouble of having to return to the main menu to print a screen image.
Printers menu

The “Printers” menu contains a sub menu with the different printers which are compatible with the FingerPrint® GSi. The sub menu consists of two pages. The second to last item on the first part of the menu is “See more printers”. Click once with the mouse or press the “return” key and the second page will appear.

One page two of this menu, a special ImageWriter II [HD] is available for users of the Apple ImageWriter II. Using this selection instead of the normal ImageWriter II setting on page one will result in graphic printing at twice the usual dot density of the ImageWriter II. Please note that this means that your print-outs will take more time and use more color ribbons. However, the resolution and results are often considerably improved.

The printer you selected by setting the DIP switches during the installation phase will appear with a check mark to the right of it. If you wish to print using another printer simply move the cursor until the printer you wish to use is highlighted. Click once with the mouse or press the “return” key and a check mark will appear to the right of the printer you selected.

Special menu

The Special” sub menu contains two options.

```
File   Options   Printers   Special   Print Screen
```

```
Output
Printer test
```

Figure 12.
The first option, “Output” allows you to select another printer port than the one you selected during the installation phase. The four viable options are the two internal ports. “Port 1” and “Port 2”, and two additional printer interface cards. “FingerPrint Parallel” and “FingerPrint Serial”. In this way you can have more than one printer connected to your Apple IIGS and easily switch between them when printing via the FingerPrint® GSi without having to change DIP switch settings.

if you select either FingerPrint® Parallel or FingerPrint® Serial a new window will appear which allows you to enter the slot in which the respective card is installed by either moving the mouse or using the right/left arrow keys.

The second and last option, “Printer Test”, allows you to test the connection with your printer by sending “THIS IS THE FINGERPRINT GSi TEST” to your printer when selected.

**Saving your first screen**

To save any screen to disk, you must first activate the FingerPrint® GSi card when the screen you wish to save appears on the monitor.

Next go the the “File option menu and select “Disk functions”. If you wish to save the screen in ProDOS skip to the next paragraph. To save a screen in DOS 3.3. you must first go to the “System selection” menu located Just after the “Disk functions” option in the “File” menu. If you were already in the “Disk functions” sub menu, return to the “File” menu and select “System selection”. Move the cursor with the mouse or arrow keys and highlight “DOS 3.3”. Click once or press “return” and a check mark will appear. The Fingerprint® GSi card will now internally operate in DOS 3.3 in regards to all disk functions and will remain so until you either change the setting back to ProDOS or reset the computer.
To save a screen in ProDOS, select the ‘Save screen’ option and a window will appear. Enter the path and file name without an extension (.TXT for example) and press return. FingerPrint® GSi automatically scans the drives to find the correct drive and adds an extension to the file name in order to identify the screen type.

To save a screen in DOS 3.3, select the “Save screen” option as above and enter the file name followed by “,S” and the slot number plus “,D” and the drive number of your 5 1/4 drive. An example is “MYFILE,S6,D1”. You can only save in DOS 3.3 to 5 1/4” diskettes.

If you wish to exit without saving the screen, simply press the ‘esc’ key.

That was easy. Read chapter 7 to get a more detailed view of the powerful disk function offered by your FingerPrint® GSi card and chapter 10 to find out how to incorporate screens you’ve saved to disk into computerized slide-show presentations using the FingerPrint® Slide-Show program.
5. Printing Screen Images

One of the great advantages of the FingerPrint® GSi is its enormous versatility when it comes to manipulating and printing screen images. The FingerPrint® GSi provides five powerful sets of options, the “Graphic Printing Tools”, “Graphic Cropping”, “Coordinate Cropping”, “Page Formatting” and “Printer Text Commands” options sets, which allow you to manipulate screen images when printing them. All of these options can be mixed and matched to create various effects providing you with a fantastic tool to create materials from programs that normally wouldn’t support printing, enabling you to get even more use out your software.

The “Graphic Printing Tools” options contains options which allow you to enlarge, rotate, inverse and flip images. These options can be mixed and matched to create a variety of effects.

The “Graphic Cropping” and “Coordinate Cropping” options allow you to select just a portion of the screen image to be printed.

The “Headings” option allows you to define a page heading which will be printed in the upper left-hand corner of each page printed.

The “Page Format” options allow you to position your image on the page and select multiple copies.

The “Printer Text Commands” option allows you to configure your printer to use different type styles and print in different sizes of text.

In this chapter we will show you how to use these options to become more creative and more productive.
Graphic Printing Tools

The graphic printing tools consist of a number of option which allow you to manipulate screen images. The most useful of these are the “Zoom”, “Rotate 90”, “Color” and “Billboard” options.

Inverse

The “Inverse” option affects only graphic screens and will reverse the foreground and background colors so that an image with black text and a white background will be printed with white text on a black background. To activate the option, click once with the mouse or press the “return” key.

This option is useful when the screen image is monochrome and appears as white on a black background. This would normally be printed as white on a black background. By using the “Inverse” option, the Image can be printed as black on a white background.

When printing color images, this option will reverse the foreground and background colors, which can create some very interesting effects.

Color

The “Color” option turns the color printing capability on or off. The default setting is off. To turn the option on or off, simply click once with the mouse or press the “return” key.

Even if you do not have a color ribbon, you can use the “Color” option to print out your screen Image in shades of grey. In this way you can simulate color. This is also the best way to print an image If you intend to make photocopies because it will have higher contrast than if you had printed the image with the color option switched off. Remember however, that images take longer to print with the ‘Color” option switched on because the printer head must pass four times on every line, one time for every color in the ribbon. In other words, if you are using a B/W ribbon and switch “Color” on, it will take longer than with “Color” off.
**Zoom**

The “Zoom” option allows you to enlarge the width and height of an image by a variable factor of one to ninety-nine times its original size. By using different values for height and width, images can be made fatter or thinner, longer or shorter.

Go to the “Zoom” option in the “Graphic Printing Tools” sub menu. Click once with the mouse or press the “return” key. A window appears with values for the enlargement factor and resulting size In Inches, as well as information regarding how many sheets of paper wide an image will be and what the best value far the Y-axis is to avoid skewing the image.

The values are modifies by moving the mouse or using the arrow keys. Move the mouse up/down and the Y-axis values will Increase/decrease. Move the mouse right/left and the X-axis values will increase/decrease. Moving the mouse diagonally will Increase/decrease the values proportionally.

To avoid skewing the image out of proportion, use the “Best Y” value as a guide for the Y-axis enlargement factor.

The “Paper strips” value tells you how wide the printed image will be and if it will go off the edge of the page. To print images that require more than one strip of paper, use the “Billboard” or “Fast Billboard” options described below as the “Zoom” Option will only print one strip of paper.

Important to note is the fact that if you are using either of the cropping options, the resulting size and paper strip values are correct and take account for the fact that only a portion of the image will be printed.

To set the values selected just click the mouse, press “return” or press “esc” and you will be returned to the “Graphic printing tools” menu.

The values in the “Zoom” variables will remain set until you change them, reset your computer or load a new program. In this way you do not have to set the variables many times if you intend to print a series of images enlarged.
**Rotate 90 degrees**

The “Rotate 90” option allows you to print any image sideways. This is very useful when making banners, or when printing images which have been enlarged and would not fit on the page if printed normally. To turn the option on or off, simply click once with the mouse or press the “return” key. A check mark will appear to the right of the option signifying that the option has been switched on.

This option can be used in conjunction with all of the other graphic printing tools including the billboard option where the affect results in horizontal strips of paper instead of vertical strips of paper.

Images from educational software can be printed as banners and placed on the wall of the classroom or used as flash cards. Screen images from drill and practice software can be enlarged and printed sideways to create great displays which can be posted around the classroom walls.

The setting will remain set until you change it, reset your computer or load a new program. In this way you do not have to set the option many times if you intend to rotate a series of images.

**Horizontal Flip**

The “Horizontal Flip” option will print a mirror image of the screen image. This option is great to use if you want to make reverse images of screens or make iron-on images for T-shirts. To activate this option, click once with the mouse or press the “return” key. Normal text from a word-processing program will be printed in reverse order but the characters will be printed right-side around. The best results are achieved with graphic images.
**Vertical Flip**

The “Vertical Flip” option will print an upside down image of the screen image. The same applies to this option in regards to standard text. To activate this option, click once with the mouse or press the “return” key.

**Billboard**

The “Billboard” option is most probably one of the most unique and most powerfull features of the FingerPrint® GSi card because of the enormous potential uses it provides. You can print posters, wall coverings, super-banners, scenery plus more in sizes up to 130 feet wide by 100 feet high.

To punt a billboard, select the “Billboard” option from the “Graphic printing tools” menu. The fist thing that you should notice is that the “Zoom” option window will appear. Set the values as described above in the “Zoom” option. When you’re finished, press “return” or click the mouse and a new window will open.

In this window you can start the printing process with “Print billboard”, enable/disable a pause between strips of paper with “Pause between strips”, and also change the starting and ending strips In order to print a particular strip, or group of strips. In a series by changing the values for “Starting strip:” and “Last strip:” respectively.

To Set the “Starting strip:” and “Last strip:” values. Just click on the option with the mouse, or press “return”, and move the mouse or use the right/left arrow keys and the value will increase/decrease accordingly. Click again with the mouse or press “return” to set the value and return to the window.

To print your billboard. just click on “Print billboard” and wait for your printer to start printing. To stop the printer. Just press the space bar. Please note that once you stop the printer you must start printing the strip in question over-again from the beginning by setting the “Starting strip:” value for the correct strip.
Once started the printer will first print a dotted line at the top of the strip with the strip number printed in the middle of the line. This is meant as an aide when you paste the strips together to make sure that they are correctly aligned.

The printer will then perform a form-feed and start printing the image itself. After printing one strip, the printer will perform a form-feed and then print the dotted line and strip number followed by the next strip.

When using the “Pause between strips” option, a blank FingerPrint® menu will appear on your screen and “Press any key to continue” will appear at the bottom of the screen. Press any key, and the printer will print the next strip.

If your printer runs out of paper in the middle of a strip, load your printer with more paper then press the space bar to stop the printer. When the FingerPrint® menu reappears, set the “Starting strip:” value with the number of the strip which was not completed and then click on Print billboard’ to restart the printer.

When you’re finished. Just click on the “<- |” symbol or press the “esc” key to return to the previous menu.

A good tip for mounting the strips on mounting board or any other firm surface is to use spray adhesive on the strips and then mount the strips as you would mount wallpaper, taking care to smooth out any bubbles. In this way you can cover a wall full of images in less than an hour.

The best color billboard results can be achieved using low price ink-jet printers which “spray” ink on to the paper and result in very even colors. Many of these printers can be found for around $200.00. Call Thirdware Computer Products for recommendations regarding brands and prices.
Fast Billboard

The “Fast Billboard” option function exactly as the “Billboard” option with the exception that the printer will print asterisks instead of filling areas with color. This option is useful when you wish to quickly see the possible results of a billboard without having to wait as long for the printer and when you intend to use the printed Image as an outline to be painted over. It’s also a good way to save on unnecessarily using up color ribbons.

Cropping images

The FingerPrint® GSi provides you with the possibility of printing just a portion of a screen Image. This is very useful when you need to create Instructional materials or graphic images from the software in your home or school. The ability of selecting portions of images provides you with the freedom to create customized graphic materials at the touch of a button. The FingerPrint® GSi provides you with two ways to crop Images: graphic cropping and coordinate cropping.

Graphic cropping

Graphic cropping allows you to select the portion of a screen image you want to print while viewing the screen Image by moving the corners of a flexible box until it covers the portion of the image that you wish to print.

When you select this option, the screen image that was on your monitor, when you pressed the FingerPrint® activator button will appear on your screen with a box around the border of the screen.
By moving the mouse, the upper left-hand corner of the box will move. When this corner is in the position you want, click once with the mouse or press the “return” key. That fixes the position or the upper left-hand corner of the box. To fix the lower right-hand corner of the box, just move the mouse and the lower right-hand corner of the box will move. Then click once with the mouse or press the ‘return key and the menu will reappear.

You will notice that the box moves slowly and is not affected by the speed at which you move the mouse. The best speed is obtained by using a slow movement until you reach the position you wish to stop at. Pause for a second in this position just to make sure that the box comes to a complete stop before pressing the return key or clicking the mouse button to fix the position.

To select just the portion of the screen image above that contains the three elves, you would move the mouse diagonally downwards from the upper left-hand corner of the screen towards the lower right-hand corner of the screen. The flexible box will change its shape accordingly. The lower right-hand corner of the box would not have to be moved as it already is in position. You would only have to click once with the mouse or press the return’ key and the menu will reappear. Then go to the “Print Screen” option and print the image or select any of the other graphic printing tools to enlarge or rotate the image.
Let's do another example using the same screen image. This time we will select the portion of the image that contains the year.
Select the “Graphic Cropping” option again and you would notice that the flexible box is in the same position as it was when we left it after cropping the elves in the image. To select the year portion of the image, Just move the mouse to the left and slightly upwards until the upper left-hand corner of the box is in the correct position and click once with the mouse or press the ‘return key. Then we would move the lower right-hand corner of the box with the mouse and click once with the mouse or press the return” key and the menu will reappear.

For greater precision in moving the cropping box, use the arrow keys instead of the mouse. One press of a key will move the box one pixel in the direction of the arrow key pressed.

By using this option you can easily select Just a portion of a screen image and create graphic images or instructional materials to fit your particular needs. If the image on your screen contains a math problem with the correct answer, you can easily select Just the portion of the screen which contains the math problem without the answer and print out a work sheet of math problems or create a quiz from any program. Just image a screen image containing a human body with labels. Select Just the body portion of the screen and you can create a quiz where the students should label the different parts of the body.

You can also use this option to crop text screens. You will notice one difference. The flexible box will consist of inverse text characters. The same also applies to cropping lowres graphic screens, the flexible box consists of inverse lowres blocks. The cropping setting will remain constant until you change it, reset your computer or load a new program. in this way you do not have to set it many times if you intend to crop a series of images. This is only valid while the screens are of the same type. or the affect will be very different.

**Coordinate cropping**

Coordinate cropping has the same affect as graphic cropping. The difference is that instead of displaying the screen image and a box on the screen, a window appears where you can alter the coordinate variables. By using the same values for a series of images, you can repeatedly print the same portion of various screens without having to repeatedly use the graphic cropping options and trial and error to select the exact same portion of the
When you select this Option, a window will appear with variables for the “X” and “Y” axis. The “X” axis is the horizontal axis, and the “Y” axis is the vertical axis.

The cursor will be placed in the From “X” and From “Y” variables. You can change the values by moving the mouse or using the arrow keys. A movement in any direction will change the coordinates just as if you were moving the upper left-hand corner of the box using the graphic cropping option. When you have fixed the position, press the “return” key and the cursor will move to the “To X” and “To Y” variables, which represent the lower right-hand corner of the box. Repeat the procedure for these variables and press the “return” key.

You will find that the best use of coordinate cropping is to crop the same portion of various images from different programs. When you change programs, you reboot your computer and the memory of the FingerPrint® GSi will be reset. After cropping the last image with the graphic cropping option, select the coordinate cropping option. Write down the coordinate values and load the next program. Activate your FingerPrint® GSi and select the “Coordinate Cropping” option. Move the mouse until the “From X” and “From Y” values are correct. Press the “return” key and repeat the procedure for the “To X” and “To Y” coordinates. A good tip is to write down the coordinates on the back of a screen dump so that you can repeat the exact same image again by simply entering the coordinate values. In this way you will not have to use trial and error to select the same portion of various screen images. The cropping setting will remain constant until you change it. Reset your computer or load a new program. In this way you do not have to set it many times if you intend to crop a series of images. This is only valid while the screens are of the same type, or the affect will be very different.

Page formatting

The page formatting options allow you to position images on the paper and print multiple copies. Also included is an option that allows you to make your printer move the paper to the top of a new page after every screen dump.
Left margin

The “Left Margin” options allows you to vary the column in which the printer will start printing. When you select this option a window will appear where you can set the position of the left margin by moving the mouse to the left or right. To change the left margin, move the mouse or use the left and right arrow keys. The value in the window will rise or fall depending on the way in which you move the mouse or which arrow keys you press. When the value in the window corresponds to the value you want, click once with the mouse or press the “return” key.

This option is very useful when you want to print images in two or more columns or center an image on the page. To print two columns of screen images, print the left hand column first, then roll back the paper and set the left margin to print the right column.

Copies

The “Copies” option opens a window where you can specify the number of copies the printer will print of the screen image. Moving the mouse to the left or right, or using the left or right arrow keys will lower or raise the number of copies that will be printed of every screen. This option is useful when you need multiple copies of the same material and will work in all modes except when printing billboards.

Top of form

The “Top of Form” option makes your printer feed the paper to the top of the next page after every screen dump. This is very useful if you are making many screen dumps and do not want to have to move the paper to the top of the page after every time you print.

Line feed

The “Line Feed” option makes your printer feed a line at the end of every line of text. The default setting is on. This option has
little importance unless you wish to print two or more screen images, one after the other, without the printer inserting a blank line between the two or more images. Another use may be that you wish to use the typewriter to type more than 80 characters of text on a line. By turning off the Line Feed option, the typewriter will not send a line feed command to the printer when you reach the 80th column, and you will be able to continue on the same line until the print head reaches the right-hand side.

Printer Text Commands

This option allows you to reconfigure your printer to print text in either “Pica”, “Elite”, “Condensed” or “Headline” sizes and either “Bold” or not “Bold” emphasis. Use the “Condensed” option to get better emphasis and proportion when printing graphics or 80 column text screens. Use the “Bold” option to improve graphics darkness. Just select the option you wish to set and click once with the mouse or press the ‘return’ key. As long as you have the printer powered on and “on-line”, the proper configuration code for your printer will be sent.

To reset your printer, you will have to power your printer off and then power it on again.

Summary

By mixing and matching the various unique and powerful options provided by the FingerPrint® GSi to manipulate images, you can easily create printed materials for classroom, work or home. Think of the advantages of being able to create homework materials, worksheets, print graphics, posters and billboards plus much more at the touch of a button.
6. Dump To Super Hires

Dump to Super Hires allows you to convert any Hires or Lowres screen to Super Hires. This is great if you want to import graphic images captured from one program and use them in paint or drawing programs that work in Super Hires. An interesting feature of this option, is that you can use all of the cropping, color and zooming features when you convert screens just as if you were printing the image to a printer.

To use this option, first set the other options, such as color, cropping and zoom. Then, just as if you were going to print the image on a printer, go to “Dump to Super Hires” and click the mouse or press the return” key.

You will see the screen clear and start flashing back and forth from the original image to the super hires image. As the super hires image appears, you might notice that the right-hand side of the screen from the edge of the image to the edge of the screen is white. This is to fill out the screen if the image does not completely fill the screen.

When the dump to super hires is complete, the menu will reappear and you should go to the “Set screen” option and activate the Super hires screen. That done, you can either print the image or save it to disk and use it in the Slide-Show program or in other graphic programs.
7. System Selection and Disk Functions

The FingerPrint® GSi offers a series of very powerful disk functions which allow you to save and load screens to or from disk, catalog disks, rename, delete, lock and unlock files and also check the amount of free space remaining on a disk. These functions work in both ProDOS and DOS 3.3 regardless of what operating system you have running in the IIGS computer at the moment you activated the Fingerprint® GSi.

System selection

The FingerPrint® GSi can operate in either DOS 3.3 or ProDOS regardless of the operating system runnin in the IIGS. However you must tell the card when you intend to perform FingerPrint® disk functions in an operating system other than ProDOS which is the default operating system for your FingerPrint® card.

To select an operating system, go to the System selection” option in the “File” menu. A sub menu will appear with a choice of either ProDOS or DOS 3.3. The currently selected operating system will have a check mark to the right. To change the selection, Just click on the right selection and then leave the menu.

By using this option you can save images form ProDOS programs in DOS 3.3 format and visa versa.

Please note that DOS 3.3 only functions with 5 1/4" diskette drives. ProDOS will work with all drives except the second 3 1/2" drive when the RAM disk option in the Apple IIGS Control Panel is configured with more than 0K RAM.
Disk Functions

The FingerPrint® GSi offers some very powerful disk functions which allow you to access files on disk while inside of programs to check for free space, file names, rename, lock/unlock and delete files, list the disk catalog and more. All of these functions are available in ProDOS and DOS 3.3.

Save screen

The ability to save images to disk allows you to export graphics and text from one program or application to another as well as capturing images for use in the FingerPrint® Slide-Show program.

Click once with the mouse or press the “return” key with the cursor on the “Save screen” option. A window will appear and you can enter any valid ProDOS path and the name or DOS 3.3 filename for the screen that is to be saved provided that that operating system is currently selected in the ‘System selection” option. Please note that me names should not have an extension (example .TXT) because Fingerprint® adds an extension which specifies the file and screen type at the moment the screen is saved.

A valid ProDOS path and file name is:

/MYVOLUME/MYFILE

When you click the mouse button, or press “return”. FingerPrint® will start to search the drives until it finds the correct one. Do not be worried if the drive light goes on in another drive than the drive containing your diskette for saving FingerPrint® screen images as this only the card searching for the correct drive.

If FingerPrint® can not find the correct volume an error message will appear at the bottom of the screen.

A valid DOS 3.3 file name is:

MYFILE
MYFILE,S6,D1
The second example contains the added slot and drive designator to redirect the current drive in DOS 33. Either one is a valid file name.

Super hires screens are saved in the Apple standard “C l” file type compatible with Paint Works Gold™ Paint8l6™ and other Apple IIGS paint programs.

Hires screens and other graphic screens are saved in standard binary formats compatible with many graphic and publishing programs.

**Load screen**

The “Load screen” option is useful when you wish to print a screen previously saved to disk by FingerPrint®. Activate your Fingerprint® GSi card. Go to the “File” sub menu and select the “load screen” option from the “Disk function” sub menu. A window will appear where you can enter the path and file name of the image you wish to import. The image will be placed into the graphic memory page corresponding to the type of graphic being imported. Go to the “Set Screen” menu of the “File” menu and make sure that the correct screen type has been selected for the screen you wish to reload into memory. If the correct screen type has not been specified, the FingerPrint® GSi will not be able to re-load your screen correctly.

After correctly loading the screen, you can manipulate and print the screen in the normal manner.

You can also use this option to forcefully import screens into certain graphic programs that might not be able to read the FingerPRint® file formats. Some programs react strangely when you import graphic images in this manner. In 816 Paint®, for example, you should select a new blank picture and the full screen option before re-loading a screen. The best thing is to experiment and see if the software you use is compatible with the standard formats before using this option.
Catalog

This function gives you a listing of the flies in the specified volume and path in ProDOS or files in the DOS 3.3 device.

in ProDOS. Just enter the path you wish to catalog and press return’ or click with the mouse. Fingerprint® will search all of the drives until it finds the path you specified. Then it will clear the menu and display the contents of the path. hi case the catalog contains more flies than ft on the screen, the listing will pause until you press any key before displaying the next screen and so on until the last file has been displayed. Press any key to return to the menu.

in DOS 3.3 the window will appear and request that you specify the slot and drive of the device whose catalog you wish to see. Use the arrow keys or mouse to position the cursor on the value you wish to change. Enter the correct value, slot 1-7 or drive 1-2 by pressing one of the number keys and then press the return key or click the mouse. The listing will appear as described above. Press any key to see the next screen of the catalog or after the last file to return to the menu.

Rename

To rename a file, select this option and a window will appear. Enter the old path and file name or file name and slot/drive if in DOS 3.3. press the “return” key or click the mouse button, Now enter the new name and again press ‘return or click the mouse button. FingerPrint® will test the validity and existence of the name before executing the change.

Delete

To delete a file, select this option and a window will appear where you can enter the correct path and file name or file name and slot/drive if in DOS 3.3. FingerPrint® will test the existence of the name and delete the file.
**Lock/Unlock**

These options will lock/unlock the specified file. Click on the correct option and enter the correct path and file name or file and slot/drive if in DOS 3.3 FingerPrint® will test the existence of the file and lock or unlock it.

**Disk Space**

This option tells you how much free space you have on a given path or device and operates just like the “Catalog” option.

In ProDOS, just enter the path you wish to check and press “return” or click with the mouse. FingerPrint® will search all of the drives until it finds the path you specified. Then it will clear the window and display the number of free blocks. Press the “esc” key to return to the menu.

In DOS 3.3 the window will appear and request that you specify the slot and drive of the device whose catalog you wish to see. Use the arrow keys or mouse to position the cursor on the value you wish to change. Enter the correct value, slot 1-7 or drive 1-2 by pressing one of the number keys and then press the ‘return’ key or click the mouse. The window will clear and the number of free sectors will be displayed. Press the “esc” key to return to the menu.
8. Set/View/Scan Screens

The FingerPrint® GSi provides you with three commands to set, view and scan the video screens (or memory pages) and their contents. These options are found in the “File” sub menu.

Set screen

This option allows you to select any of the available video memory pages for printing or saving to disk. When you select this option, a list of the Apple IIGS video memory pages will appear on the screen. Simply move the cursor until the screen you wish to use is highlighted and click once with the mouse or press the “return” key. A check mark will appear to the right of the page you have selected. This option is useful when you wish to select a memory page other than the page that was on the screen of your computer at the time you pressed the FingerPrint® GSi activator button. Any use of the “Print Screen” or “Save To Disk” options will be executed using the selected screen.

View screen

This option allows you to view the currently selected video memory page which would normally be the image that was on the screen of your computer when you pressed the FingerPrint® activator button if you haven’t used the “Set Screen” option or “Scan Screen” option to change the setting.
Scan screen

This option allows you to scan the contents of the different video memory pages by moving the mouse left or right, pressing the space bar or using the left and right arrow keys. When you have found the screen you wish to select, press the “return” key or click the mouse button and the menu will reappear. The screen has now been selected and any use of the “Print Screen” or “Save To Disk” options will be executed using the selected screen.
9. Using The Desktop Accessories

The “” accessories menu contains the FingerPrint® GSi desktop accessories. These consist of a calendar, calculator, and a typewriter. The accessories can be accessed at any moment, from inside of any program to make quick calculations, type diskette labels, add explanatory text to screen dumps, check future and past dates and more.

Calculator

Select the “Calculator” option from the menu and a calculator will appear on the screen. The calculator will perform the four basic mathematical operations and calculate percentages. To calculate a value, enter the first number, then the operation (“+” = addition, “-” = subtraction, “/” = division, “*” = multiplication), then the second number. To see the result press the “=” key or enter the next operation to continue the calculation.

To calculate a percentage, enter the first number, the operation, then the second number followed by the “%” key and the “=” key or the next operation.

Numbers can be edited while in the entry display. Use the right/left arrow keys or slowly move the mouse to the right or left to position the cursor on the digit you wish to edit. Use the “Delete” to remove digits or enter the correct digit or decimal point and the old digit will be overwritten.

The “D” button will completely clear the calculator memory, display and “paper strip”.

The “C” button will clear only what was showing in the entry display and will not erase on-going calculations. Use this function to erase incorrectly entered numbers.
To leave the calculator, simply press the “esc” key at any moment.

---

**Calendar**

The calendar accessory displays the days of the month for the current month of the current year, provided that your system dock is correctly set. To view other months, move the mouse to the left for past months or to the right for future months. To view other years, move the mouse upwards for future years or backwards for past years. The right/left and up/down arrow keys can also be used to change the month or year.

When you’re finished, press the “esc” key and you will return to the menu.

---

**Typewriter**

The typewriter function allows you to write diskette labels, add text to screen dumps or even write this manual.

To use the typewriter, just select the option from the menu and enter text. When the text reaches the right margin the text will wrap around to the next line and the completed line will be sent to the printer. To send a short line to the printer simply press the “return” key after the last character in the line. To make sure that the printer has printed every character you entered and to flush the buffer, simply press the “return” key before leaving the typewriter and this will force any remaining text out to the printer.

To correct anything on a line before pressing the “return” key, use the right/left arrow keys to move the cursor and either type over the text or use the ‘delete key to erase characters to the right of the cursor.
You can set the left and right margins like an electric typewriter. To set the left margin, press the option key and, keeping the “option” key pressed, press the right arrow key. Each time you press the right arrow key while the option” key is held down, the left margin indicator.“‘”, will move one position to the right. To move the left margin backwards toward s the left, repeat the procedure but press the left arrow key instead of the right arrow key.

To set the right margin, repeat the procedure described above but use the (open apple) key instead of the “Option” key. The left arrow key will move the margin towards the left and the right arrow key will move backwards towards the right.

When you’re finished typing. Just press the (open apple) key and “escape” key at the same time any you will be returned to the menu.

The typewriter accessory can also be used to send special commands to your printer. Control codes can be entered by pressing the “control” key while pressing another key. The resulting characters will appear in inverse video so that you can differentiate them from normal characters, Escape codes can be entered by pressing the “escape” key followed by the number or letter key corresponding to the command. An inverse left bracket will appear to represent “esc” key in the typewriter display. Remember to always end your command line with the “return” key or the command will not be sent to the printer.

A good use of the typewriter is to print screen images on the left-hand side of the page and then add text with the typewriter on the right-hand side. Screen dump an image, then roll back the paper in the printer and set the left margin before entering typing the text. This way, the text will be printed to the right of your image.

The same can be done to center text under a printed image. Set the left and right margins according to your needs and type the text.
10. The FingerPrint Slide-Show Program

The FingerPrint® Slide-Show program allows you to create computer presentations of screens captured and saved to disk using the FingerPrint® GSi card. These presentations can be run either as manual presentations where the operator presses a key to advance/reverse a slide, or as self running presentations for use in store windows, classrooms, exhibitions, board meetings and more. By simply connecting a big screen TV to your computer. a slide-show can be shown to a collection of students, employees or other audience. You can even connect your computer to a video recorder and create video cassettes of your presentations where you can add music and narration. The FingerPrint® Slide-Show is a very powerful tool and can be utilized for many exciting applications in the home, school, store, exhibit, office, waiting room etc

A slide-show is a collection of slides or captured images. Before we can create a show you must have a few slides on a diskette. Important to note is that the slides must be saved in ProDOS and only images captured using the Fingerprint® GSi card can be used with the Slide-show program. If you wish to use other images or screens, simply get them on the screen of your computer and save the image with FingerPrint®.

The Slide-Show program has six basic features: run a show, modify a show, erase a show previously created, display an individual slide, create a show and create auto start-up versions of the Slide-Show program which will start a specific show automatically when the computer is powered on or booted with that diskette. This is a great tool to use for sending presentations if software or graphic images which run themselves.

*The Slide-Show program diskette is not copy protected and may be copied as many times as you wish provided that you do not sell diskettes containing the FingerPrint® Slide Show program, remove the copyright information or alter the program in any way without the written permission of Third ware Computer products.*
Start up the Slide-Show program by booting up the diskette that came with your Fingerprint® GSi. A menu will appear with the different options: Run, Modify, Erase, Display, Create. Startup and Quit at the top of the screen. By moving the highlighted cursor using the right/left arrow keys, you can highlight the different options. As you move from one option to another, a description of the option will appear near the bottom of the screen. The bottom line of the screen contains Information and messages regarding what keys to press at any given time and their respective functions.

Move the highlighted cursor around the different options and read the descriptions. You can also use the first letter of the option to activate the option. First of all, let’s create a show. Please make sure that you have a diskette with some captured images at hand.

**Create**

To create a show, you will be presented with a list of available slides and you eliminate the slides from the list until only the slides you wish to include remain. For this reason it is easiest to copy the slides you intend to include in a slide-show on to one or two diskettes if you have a large Library of captured images.

Move the highlighted cursor to the “Create” option and press “return” or just press the “C” key. The program will ask for a pathname at the bottom of the screen. You have the choice of either writing the pathname corresponding to your captured images or pressing the “return” key and the program will search all of your drives for images captured by FingerPrint®.

If you only wish to work with slides from a given directory or path, enter the pathname when you start this option. If you wish to work with a wide variety of slides from various directories or paths, press the “return” key and the program will search your drives. Please press the “return” key. The program will look at
your various drives and display a new menu together with a list of all of the slides the program found on all of your drives.

The list of slides contains information regarding the position of the slide in the show (Order), the time the slide will be displayed (time) and the name of the slide.

The new menu, contains a new set of options: Sequence, Time, Erase, Duplicate, Reverse, Break, Pause, Credits and Quit. Sequence is used to change the position of a slide within the show. Time is used to set the display time the slide will have when the show is run in automatic mode. Duplicate is used to copy or repeat a slide in the show. Reverse. Pause and Break are switches which allow or do not allow the user of the finished show to change direction during the show, pause the show or leave the show and return to the menu. Credits is a marker that indicates that a slide will be used for credits and will only be shown once at the beginning of the show.

Let’s first eliminate the slides we do not wish to include in this first show.

By moving the up/down arrows, a pair of markers will move up or down in the list of slides. When you arrive at a slide which you wish to eliminate . make sure that the marker is correctly positioned and press the “E” key. The program will ask you Are you Sure?”. **This process does not delete slides from the diskette, it Only strikes them from the list on the screen.** Press the “Y” key to confirm your command. The slide will disappear from the list. In this way you can eliminate the slides that you do not wish to include in this show.

Now let’s rearrange the order of the remaining slides so that they appear in correct order.

By moving the up/down arrows, a pair of markers will move up or down in the list of slides. When you arrive at a slide which you wish to move . make sure that the marker is correctly positioned and press the “S” key. The slide will be highlighted and by using the up/down arrow keys, the slide will be moved upwards or downwards in the list. When the slide is correctly positioned, press the “return” key.

Now let’s set the time that the slide will be displayed before the next slide is shown.
By moving the up/down arrows, a pair of markers will move up or down in the list of slides. When you arrive at a slide which you wish to set the time for make sure that the marker is correctly positioned and press the T key. The cursor will highlight the first position of the time value and you can enter any time value from 0-9999 seconds. The shortest time a slide can be displayed varies depending on the captured screen image type. but normally the minimum is approximately 3-5 seconds. When you finish entering the time value, press the ‘return key.

Now jets duplicate a slide, so that we can show it more than once in the same show.

By moving the up/down arrows, a pair of markers will move up or down in the list of slides. When you arrive at a slide which you wish to duplicate, make sure that the marker is correctly positioned and press the “D” key. The duplicate of the slide will appear directly after the slide in the list.

If you wish to provide the user of your show with instructions or credits which will only appear at the beginning of the show, you can create screens in paint or draw programs with instructions or credits and capture them them using FingerPrint®. Move the marker to the slide(s) you wish to use as credit screens and press the “C” key. An asterisk will appear to the left of the slides name. To unassign a slide as a credit slide, repeat the process and the asterisk will disappear.

If you want to enable/disable the user of the show from being able to reverse direction in mid show, pause the show or break the show. Just press the “R” key for reverse, the “P” key for pause and the “B” key for break. At the bottom of the screen you will see the current values for these options. On means that it is enabled and off means that it is disabled. If you run a show endlessly with the break option disabled, the only way to stop the show is to reset or power off the computer.

To save the show you’ve created, press the “esc” or “Q” key and the program will ask you for the name you wish to give the show. Enter a name and the program will ask for the name of the volume where you wish to save the show. Press the “return” key to accept the current volume or press the space bar to scan the volumes and use the arrow keys to select from the volumes found during the scan.
Important to note is the fact that the slide-show should be saved in the root of the volume where the program will create a directory called “FPSHOW” where it will save the files.

Now that we’ve created a show, let’s run it!

**Run**

To run a show you’ve previously created, press the “R” key and the program will ask you for the name of the volume where the slide-show is located. Press the space bar to search the volumes and use the arrow keys to see which volumes were found, or press “return” to accept the suggested volume.

The program will display a list of the slide-shows it found on the selected volume and you can select the show you wish to run by using the up/down arrow keys to move the marker. Press the “return” key to run the show you’ve selected.

The program will ask you how many times to run the show. Answer from 1-99 times or press “return” to run the show endlessly.

The program will clear the screen and prompt you to press any key to start the show. Press any key and the first slide or credit screen will appear.

When running the show, you can change direction of the presentation by pressing the “delete” key. Press the “return” key to advance one slide in the current direction. Press the space bar to pause the show and press the space bar again to continue.

To break out of a running show before the end, press the “esc” key and you will return to the program main menu.

Of course, the above options can be disabled by the creator of the show so that you can not change direction, break or pause the show, see “Create” for more details.

Now you know how to create and run a show.
**Modify**

Modifying an existing show is very similar to creating a show. The menu and commands are the same. In this way you can create and modify shows to suit your needs.

To modify a show you’ve previously created, press the “M” key and the program will ask you for the name of the volume where the slide-show is located. Press the space bar to search the volumes and use the arrow keys to see which volumes were found. or press ‘return to accept the suggested volume.

The program will display a list of the slide-shows it found on the selected volume and you can select the show you wish to modify by using the up/down arrow keys to move the marker. Press the return key to modify the show you’ve selected.

The program will then display the same menu and options as in the “Create” option. See the description on that section for more details on individual commands.

To add additional slides to the show you must create a new show.

---

**Erase**

To erase a show you’ve previously created, press the ‘E” key and the program will ask you for the name of the volume where the slide-show is located. Press the space bar to search the volumes and use the arrow keys to see which volumes were found, or press “return” to accept the suggested volume.

The program will display a list of the slide-shows it found on the selected volume and you can select the show you wish to erase by using the up/down arrow keys to move the marker. Press the “return” key to erase the show you’ve selected.

**Erasing a show does not in any way delete the slides that made up the show.**
Display

To display a slide you’ve previously saved, press the “D” key and the program will ask you for the path name of the volume where the slide-show is located. Press return to search the volumes or enter the path name.

The program will display a list of the slide it found on the selected volume and you can select the slide you wish to display by using the up/down arrow keys to move the marker. Press the “return” key to display the slide you’ve selected.

The slide will appear on the screen and you can return to the menu by pressing the “Esc” key.

in this way you can easily check any slide if you forget what it looks like. Also you can use the FingerPrint® GSi “Load screen” option in the “File” menu to load any screen saved with FingerPrint® GSi back into memory even if you’re in the middle of the Slide-Show program.

Startup

This feature allows you to create disks that will automatically run the first slide-show in the directory when the computer is powered on or the diskette booted.

This a great way to make self-running demos, presentations or instructional disks which the user need only insert into the drive and start the computer to see.

Just press the “S” key and the program will ask you for the name of the volume where the slide-show is located. Press the space bar to search the volumes and use the arrow keys to see which volumes were found, or press “return” to accept the suggested volume.
The diskette has now been converted to auto-start. If you do this by mistake, just repeat the process before removing the diskette in question. If you have removed the diskette and left the program, just press the FingerPrint® button and go to the “File” menu. Select the “Disk functions” option and choose ‘Catalog’. List the files in the path of your slide-show diskette. You will notice two files, “SSHOW” and “ASHOW”. The “ASHOW” file appears as “ASHOW.SYSTEM” while the “SSHOW” file does not have the extension “.SYSTEM”. Press the “esc” key, and select the “Rename” option. Enter “SSHOW” and press the “return” key. Then enter “SSHOW.SYSTEM” and press the “return” key. Now the diskette will function normally again.
11. Using Other Printer Interfaces

The Fingerprint® GSi provides you with the ability to print screens via any of four different printer ports. The first two ports, “Port 1” and “Port 2”, are the Apple IIGS two Internal serial ports. The second two ports, “FingerPrint Parallel” and “FingerPrint Serial” are either any Fingerprint parallel or serial interface card placed in slot #1 and declared to the control panel.

You selected your default printer port when you Installed your Fingerprint® GSi card by setting DIP switches 6-7. To select another printer port, use the “Output” option in the “Special” sub menu. Your default printer port, or the currently selected printer port, will be shown with a check mark. To select another port, move the mouse, or use the arrow keys, to position the cursor over the port you wish to select. The click once with the mouse or press the “return” key and a check mark will appear to the right of the port you selected.

In this way, you can use a printer connected to any of the internal ports or an extra parallel or serial printer interface installed in slot #1 to print your screen dumps.
12. Troubleshooting

If your Fingerprint® GSi should freeze up or not function properly, follow this procedure and try to do what you were trying to do again. If that fails, please contact Thirdware Computer Products Customer Service Department between 2:00PM-5:00PM EST at telephone number (305) 592-7522 and they will be more than glad to help you.

Fingerprint® GSi does not print correctly.

1) Check the “Printers” sub menu to see what printer is selected.

2) If this is not your printer, change the DIP switches accordingly and try again

3) If it is your printer, turn everything off and try again.

4) If that does not work, call Thirdware or your dealer.

Fingerprint® GSi gets stuck

1) Press the “escape” key, “return” key or click the mouse button repeatedly.

2) If nothing happens. turn everything oft and stan over again.

3) If the error repeats itself, note down the details of what program you were using, where you activated the Fingerprint® GSi and what option you tried to execute.
4) Contact Thirdware Computer Products and report the problem.

Fingerprint® GSi does not interrupt correctly.

If the Fingerprint® GSi menu does not appear as soon as you release the button and your program continues to run uninterrupted, try pressing the Fingerprint® GSi activator button for a couple of seconds and then release it. Some processes require a couple of seconds for the interrupt to stop the program.

How to get help

If all of the above hints don't help you, call Thirdware Computer Product's Technical support department (305) 592-7522 between the hours of 2:00-5:00PM EST and a service engineer will be more than glad to answer your questions free of charge.

If you can not call, please address any correspondence to:

THIRDWARE COMPUTER PRODUCTS
Customer Service Department
4747 NW 72nd Avenue
Miami, FL 33166

IMPORTANT

DO NOT EVER SEND OR RETURN ANY PRODUCT OR PART OF A PRODUCT TO THIRDWARE COMPUTER PRODUCTS WITHOUT FIRST HAVING RECEIVED A VALID RETURN AUTHORIZATION NUMBER FROM THE TECHNICAL SERVICE DEPARTMENT OR YOUR PACKAGE WILL BE RETURNED UNOPENED.
Thirdware is not responsible in any way for items lost while in transit.
13. Reference Section

This section contains technical information regarding DIP switch settings and ideas for applications.

DIP Switches

You only have to read this section if you are using a printer other than the Apple ImageWriter II or if you want to know how change the DIP switches of your Fingerprint® GSi.

Take a look at the following table of printers. There you will find all of the DIP switch settings necessary to use most printers. If your printer is not listed, try the “Epson Generic” settings. If these do not work properly, contact Thirdware Computer Products customer service department and they will tell you how set the switches for your printer. Be sure to write down the setting they give you and fill in one of the blank switch diagrams listed at the end of the list of switch settings. In that way you will know where to find the setting should the need arise in the future.
Printer DIP Switch Settings

Note: Switches 6-7 set the default poll. Switch 8 has no function and can be ignored.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>PRINTER</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Apple ImageWriter II</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Apple ImageWriter I</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Apple ImageWriter LQ</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Apple Scribe</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Cannon</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Citoh</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Citoh 8510</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Epson (newer models)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Epson (generic)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Epson JX</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>IDS Prisma</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>IDS Color</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Oki 82, 83, 92, 94</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Oki 100 &amp; 200 series</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Quadjet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Fastext</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Panasonic</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Gemini</td>
<td></td>
</tr>
</tbody>
</table>
If you don’t have one of the above printers and the customer service department at Thirdware has provided you with alternate DIP switch settings, use the following blank switch diagrams to record the suggested settings.

(If your printer is not listed, try Epson Generic.)

Other: _______________________
Other: _______________________
Other: _______________________
Other: _______________________
Other: _______________________
Other: _______________________
Other: _______________________
Other: _______________________

When you know the DIP switch settings for the printer you are using, change the switch settings using your finger or a pen to move the switch, so that switches 1-5 are correctly positioned.

Check the DIP switch setting with the setting in the table or the setting you received from Thirdware Computer Products customer service department. Are they set correctly?
Okay, now your ready to reinstall the FingerPrint® GSi in your Apple II GS. Make sure that you have set switches 6-7 correctly for the port you will be using as your default.

Look at the chart below to see how the switches 6-7 should be set for the port you will be using.

<table>
<thead>
<tr>
<th>Port 1</th>
<th>Port 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>FingerPrint® Parallel</td>
<td>FingerPrint® Serial</td>
</tr>
</tbody>
</table>

Use your finger or a pen to move switches 6-7 so that they are correctly positioned for the port you will be using.

---

**Changing ROMs**

The Fingerprint® GSi comes with either two 128K ROM chips or one 256K ROM chip installed. As Thirdware develops new features and enhancements for the FingerPrint® GSi, new ROM chips will be made available. Owners of FingerPrint® GSi cards wanting to upgrade their FingerPrint® GSi cards can order ROM upgrade kits from Thirdware or your local dealer.

The following will explain how to remove and replace the ROM chips on your Fingerprint® GSi.

First, locate the ROM chips on your FingerPrint® GSi card. Use the diagram on the next page as a guide.
The ROM chip should have a golden label with “Fingerprint® GSi™” written on it. If your FingerPrint® GSi card has two 128K ROM chips, then there should be another chip, labels either ‘Thirdware” or “Fingerprint® FK”. Just above the ROM chip with the “FingerPrInt® GSi” label. If your card does not have this second chip, then you have a 256K ROM version.

Before attempting to examine or remove the ROM chips, be sure to turn your computer off and remove the FingerPrint® GSi card. Never insert or remove a card from your computer with the power on!

Use a flat headed screw driver or a narrow knife as a lever to lift up the ROM chip by inserting the knife or screw driver between the ROM chip and Its socket. Lever either side of the chip carefully until all of the legs have come free of the socket. Be very careful not to damage the socket or the ROM chips.

If you examine the replacement ROM chip(s) you will see that they have a notch on the left-hand edge of the chip. Making sure that this notch Is to the left, carefully insert the ROM labeled “FingerPrint® GSi” in the bottom most ROM socket. Make sure that each and every one of the legs are properly positioned, and that the notch is facing the left, before pressing carefully on the chip. Make sure that all of the legs entered correctly and that none were bent or damaged. If you received two replacement ROM chips. Insert the second chip in the socket immediately above the ROM chip you Just installed using the same care as with the first chip.
Check to make sure that both chips have the notch facing the left and that all of the legs entered their sockets correctly.

Now we have to check the ROM shunts. Look at the diagram of the card on the previous page. You can locate the shunts on the left-hand edge of the card. Use a thin nosed pair of pliers or tweezers to lift the shunt and place them correctly depending on what ROM chips you have installed. See the diagram below for the respective settings.

<table>
<thead>
<tr>
<th>Two 128K ROMs</th>
<th>One 256K ROM</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Diagram of Two 128K ROMs]</td>
<td>![Diagram of One 256K ROM]</td>
</tr>
</tbody>
</table>

Make sure that the shunts are correctly positioned before re-installing your FingerPrint® GSi card in your Apple II GS. If in doubt as to the exact procedure for installation, see the chapters covering installation earlier in this manual.
Dumping the FingerPrint® Menu’s

You can print the Fingerprint® GSi menu screens to your printer by pressing the 🍎 (open apple) key and the “P” key simultaneously while in the FingerPrint® GSi desktop. This option will not work if the “caps lock” key is not depressed or if you are in the typewriter, calculator or calendar accessories. To print these accessories, return to the accessory menu and while they are still on the screen press the 🍎 (open apple) key and the “P” key.

Ideas for Applications

More detailed information regarding specific applications of the FingerPrint® GSi in education and at home can be found in Thirdware Computer Products “FingerPrint® User’s News Letter”, published six times annually. One years subscription costs $3.00. To subscribe, send us the subscription application you received in the box, or send us a note requesting a subscription. Make sure to include a check for $3.00 or your subscription will not be processed.

If you have a specific application of the FingerPrint® GSi card that you would like to share with other FingerPrint® users, we would be glad to include it in the “FingerPrint® User’s News Letter”. Just send us a note with your application and we will publish it on a first come first serve basis.


(1988-03-12)
Unleash the full power of your Apple computer and take full control of your printer and software. Become more productive and more creative by using FingerPrint® enhancement products from Thirdware Computer Products, the personal computer enhancers. Makers of high quality computer enhancement products since 1983.

THIRD WARE COMPUTER PRODUCTS
A Division of Precision Software, Inc.